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LANDSCAPE ASTROPHOTOGRAPHY– THE SHOT 

by Cristian Fattinnanzi 

Introduction: this small guide is aimed especially at those who are passionate about photography and are interested in 

taking pictures of the starry sky and its wonders. Those of you who are already experienced photographers will find 

technical terminology that is already known to you as well as some new terms that are specific to astronomy 

photography, which I will attempt to explain and make clear. The final goal is to be able to create a sequence of 

information that will take anyone through a night-time photo session, from the choice of the right night to schedule the 

outing to the development and elaboration of the acquired files. 

Choosing equipment 

In order to start taking a few shots of the sky, one must have a camera with the option to extend 

the exposure time up to at least 30 minutes. Another essential accessory is a tripod to hold the 

camera firmly in place. If you have to buy one, avoid purchasing models that are spindly or with 

many plastic parts. A good tripod for night-time photography will weigh at least 1.5 kg and have a 

load capacity of at least 5 kg. In any case, it would be best not to exaggerate in the extension of 

the legs when you are using it. Often one meter is already more than enough for comfortable use 

without jeopardising its stability. If the tripod has a central lift column, avoid raising it. Extracting it 

will considerably diminish its stability. A tripod and a reflex camera (or even an advanced point 

and shoot camera) are enough to aim at the stars and obtain very interesting results! Other 

useful accessories include: spare batteries as the long exposure times and low nocturnal 

temperatures generally consume more energy, programmable timers for exposures that may 

exceed 30 minutes, and fast lenses (it would be best to have an aperture of at least F/2,8). 

Choosing the day! 

Not all evenings are ideal for shooting the night sky. 

For example, we must choose a date and time when 

the moon will not create disturbances in the photo with 

its diffused light, which makes the entire sky too bright. 

So, with a calendar in hand, we must identify the best 

days, namely those around the “New Moon” phase, 

which is generally indicated with a black dot on 

calendars. Using this day as a reference, we can 

identify the best period in the two weeks around it, the 

week before and the week after. Within this period the 

moon will not bother you during the hours in the middle 

of the night since it may either rise a little before dawn 

or set slightly after the sun sets. You must understand 

that the moon already limits the days that are useful in 

each month by about 50%. You can use a software 

program to help better understand the optimal periods 

based on the phases of the moon. I would recommend a very complete program that is free of charge and can be 

downloaded from the internet: Stellarium. Once installed, you can choose your observation point on Earth, set the 

date and time you are interested in and check what will be present in the sky for any given time. 

Keep an eye on the weather 

When taking pictures of the heavens it is important to evaluate meteorological 

conditions with care. When you wish to frame the sky with earthly subjects such 

as mountains or characteristic buildings, a few passing clouds (that are not 

overly invasive) can create a nice choreography and enrich the picture's 

composition, but such are generally very rare situations. It is far more frequent 

that you will encounter evenings that are not very clear, if not completely 

overcast. Especially when you are in the mountains, the weather can change 

quickly and the weather forecasts are not always able to evaluate all the factors 

in play in order to provide reliable information. A beautiful, clear day is not 

always followed by a night that is as favourable, since the drop in temperature 

tends to generate water vapour that rises at night and reduces the transparency 

of the night sky. You must therefore acquire a certain amount of experience and 

try when the conditions are promising. On very humid nights the front lens of the camera can fog up. The first solution 

I can recommend is a lens hood. They generally provide less protection to wide-angle lenses than other lenses, but it 
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does do something. Then, naturally, the ideal solution is a dew heater. I remember that on evenings of astronomical 

observation with telescopes, someone would randomly attempt to use their iPhone to record images, but electrical 

devices like these require 220 V current and that is not always available. There is no way to avoid that some nights 

will not be favourable, and some of those times may be after rather arduous travel to reach the spot. It happens! 

However, you must not be discouraged. You can chalk it up to experience! 

Choosing the location 

A nuisance you will soon have to face is the plague of light pollution. Despite many minor attempts at regulation, 

infractions and exceptions are the order of the day. Add to this the lack of any kind of enforcement or sanctions, and 

sadly we are witness to a constant increase in nocturnal lighting. The lights that point into the sky (spotlights, 

reflectors, advertising, etc.) make 

the sky lighter than the natural 

darkness that is its nature. Like 

the moon these lights obstruct 

our view of the most subtle 

elements of the Milky Way or the 

nebulas we are trying to 

photograph. It would suffice to 

promote a healthy culture with 

regard to lighting and energy 

saving (pointing lights into the 

sky illuminates nothing but the 

sky itself, so the energy is 

pointlessly lost into infinite space) 

to save power and money or 

improve lighting where it is 

properly needed: on Earth. When 

choosing your location you can 

make use of the numerous maps 

that report the intensity of light 

pollution. Those sites furthest from large cities, and not necessarily at high altitude, are naturally preferred (the sky is 

also darker in the mountains because there are no large cities or industrial centres nearby). Remember that the most 

important direction is to the south, where all the astronomical objects “culminate” and can therefore be observed under 

the best conditions. Keep this in mind when choosing your point of observation or photography. 

Getting ready! 

Before leaving for the night in question, you must carefully check that you have everything you need with you. 

Forgetting even a simple accessory can prejudice the entire evening. If the evening is one of those “memorable” ones, 

it would be a pity not to be able to enjoy it fully. Obviously, the reflex camera, lenses, tripod and batteries are 

indispensable. What we are most often capable of forgetting are those less evident elements, such as torches, the 

tripod base (that might have been left attached to the bottom of 

some other camera or lens), the lens hoods (at night lenses can 

fog up, and the lens hoods prevent this problem), 

programmable timers for long exposures (and extra batteries for 

them), and memory-cards. So far we have addressed the 

photographic equipment, but we must not forget the “thermal” 

equipment needed in the mountains. Especially in the winter, 

but generally at night, the temperature can drop far more than 

we would expect. So it is best to cover up and wear hiking 

boots, wool socks, gloves, fleeces, hats, winter coats and all the 

rest. While taking astronomy photos, which often lasts for many 

minutes, there is very little to do. Staying still facilitates a loss of 

your body heat, especially if you do not take refuge in your car. 

So it is a good idea to bring some further protection from the cold, such as a tent, sleeping bags or blankets. If you 

have chosen a somewhat out of the way location, it is a good idea to have at least one other person to help in case of 

more serious accidents. For the same reason, it is best to head out with your phone fully charged. Water is 

fundamental, as are a few snacks. A knife is always useful. A few mechanical tools or maybe a survival kit (no need to 

kit up like Indiana Jones) are also advisable. You must then make certain the means of transport you intend to use is 

suitable to reach the chosen location. Check the battery charge and the condition of the tyres, that they are winter 
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tyres if there is the chance of snow or ice, and if you are going on dirt roads it would be best to ensure their pressure 

is not too high. 

Are we leaving... or are we spinning? 

After this extensive series of recommendations, we can finally address the more technical aspects and specifics of 

night-time photography. What can we do with a tripod? Or with a star tracker if one day we wish to acquire that useful 

astronomy accessory? When using a simple tripod your shots will inevitably show some blurring due to the Earth's 

rotation, which (apparently) moves the sky above us. In 

reality the sky is not moving, but rather it is we 

“earthlings” who are on a sort of spinning top travelling 

around the sun, and that movement also makes our 

photography tripod move. Many photographers make 

use of this movement to obtain particular effects due to 

the trailing of the stars, resulting in curious curved lines 

across the sky. The so called “Star-trails” (the free 

software “Startrails” is useful for elaborating images of 

this type) are easily visible in many night-time pictures 

thanks to their particular appearance. These images are, 

on one hand, testimony to the rotation of our home 

planet, but on the other hand can be somewhat dull in 

that they show very little of the true beauty of the starry 

sky. There are those who have employed this 

phenomenon to create even stranger effects, such as vortexes, zoom effects, or star trails that increase in brightness. 

These are indubitably curious, but personally I care little for them as it is best to avoid artificial effects in astronomy 

photography (and it is sometimes quite complicated to achieve said effects) since they distance us from the actual 

beauty of the stars, constellations, and I dare say the scientific value of what we have achieved. 

The point of view! 

A beautiful photograph, whether for astronomy or not, depends very little on the quality of our equipment. Other 

factors, that I would define as “human” factors, are far more important: good taste, a good eye, experience, creativity 

and the photographer's technical skill. Post-production also is a significant contribution to the success of the image, 

but at the base there must be a good idea. In this guide we will also discuss post-production further on. Getting back 

to the point of view of the picture, a photographer who brings together the starry sky and the landscape follows rules 

that are quite the same as those of a classic landscape 

photographer. First and foremost among them is the famous 

rule of thirds. You must take care to have a clear vision of the 

portion of sky you wish to shoot and that the target subjects 

are not too close to the edges of the image. The horizon must 

be perfectly horizontal (however it is possible to correct this in 

post-production). The elements on the ground must be 

identifiable and interesting with intermediate subjects (so 

called mid-ground) placed so as to create depth and volume to 

the shot. Where possible, the subjects should be aligned to 

create vectors leading to the corners of the image. In order to 

get a grip on all these parameters, you must walk a bit “in the 

field”, in order to find the ideal spot. Do not forget the altitude 

of the spot you shoot from has a great effect on the result, in particular when using the larger wide-angle lenses, as is 

common in landscape astrophotography. When fish-eye lenses are used, everything appears to be smaller. If you are 

trying to focus on and place earthbound objects in the foreground (a rock, a puddle, a flower, a trunk, etc.) you must 

get extremely close to it, even within 50 cm! That way its shape will take up more of the surface area and will become 

more “important” within the balance of the image. Based on this subject you can compose the rest of the image by 

trying to find an ordered disposition of all the elements in the frame. Over time and with experience you will learn how 

to better manage these aspects. In the meantime, when the weather does not cooperate or the moon is bright at night, 

some good photography books or astronomy magazines can be of great help in this regard. 

Let's get ready to shoot! 

Have you found the right spot from which to shoot? Excellent. Place the tripod securely on the ground and mount the 

camera on it. But what parameters do you set on the numerous adjustments that digital cameras provide us? It's 

a good idea to have everything you must have set in mind, in order to avoid silly mistakes that could compromise the 

results of an entire night-time session! Here below is what I suggest: 
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-RAW image format. This format allows you to fully record the information acquired by the reflex, 

unlike jpeg that simplifies much of the data gathered. The RAW format also allows you to 

perfectly manage the image's colours in the later elaboration phase. RAW is a very heavy 

format, so check that there is enough memory on your cards for the number of images. 

-Choice of FOCAL LENGTH. It is quite trivial, but clearly if you have a zoom 

lens you should choose a focal length best suited to what you want to 

photograph. If you have a “full-frame” (FF) reflex, that is with 36x24 mm 

image sensor like film once was, the focal length for the lens will be the 

actual length. If you instead are using a reflex with a reduced format (APS-

C), you should multiply the focal length setting by 1.5x (Nikon) or 1.6x 

(Canon) to ensure it is comparable to the reference focal length, which is 

that of the film format (FF). So if you use a lens with a focal length of 50 mm 

on an FF (the generally accepted “normal”), for the same framing on an 

APS-C reflex camera, you will need to have a focal length of circa 32 mm 

(50 divided by 1.5 or 1.6). 

-the exposure TIME. To determine the maximum exposure time in order not to have evident movement in the star 

trails you need only do a simple calculation:: 300 divided by the FOCAL length in mm = Seconds of maximum 

exposure. This way you get the number of seconds in the maximum exposure before the stars become too blurred. 

This formula was obtained based on the characteristics of recent digital reflex cameras, which have pixels measuring 

circa 5-6 microns. Applying this formula you will obtain a movement of the star trail 

of circa 3 pixels, which is an acceptable compromise. To lengthen the exposure 

time you can “modify” the rule and, for example, use 500 divided by the focal 

length, and you already know that, proportionally, you will have about circa 5 pixels 

of movement. So, if you use a 14mm wide-angle on an FF reflex, the maximum 

recommended time will be circa 22 seconds. If the same lens is mounted on 

a reflex camera with an APS-C sensor, the equivalent focal length will be 14x1.5 

= circa 21 mm, so the maximum exposure time would drop to circa 14 seconds. 

This is because there is greater magnification of the image on APS-C and this 

means the movement will inescapably become evident earlier. These rules are to be taken into account when there is 

no possibility to follow the sky's movement. If you have a star tracker the exposure times can be extended, allowing 

you to make multiple shots of the same subject and work with lower ISO and have cleaner files. For times over 

30 seconds, set the “B” (BULB) exposure. In “B”, thanks to an accessory such as a programmable timer, you can 

choose any exposure time (and pause) without having to press the shutter button for the entire duration of the 

exposure (which causes the reflex camera to vibrate). 

-The APERTURE. Earlier we stated that when photographing at night, 

with low light conditions, it is highly recommendable to have a fast optics, 

so with a low focal ratio. This means that an F/2.8 would be very good, 

while an F/5.6 would have some difficulties because it is optically 

“slower”. There are optics that are faster than F/2,8, such as some F/1.4 

or F/1.8 lenses, that at times are not even expensive. These would 

appear to be optimal for this kind of use. There is a “but” though: when 

used at full aperture, very fast lenses often are not very sharp, especially 

in the corners of the photograph. Indeed, it is in the corners where, 

despite a precise focus in the centre of the image, you may see some 

stars of a rather curious aspect, as though they were swallows, little 

balls, or butterflies. Careful: it is not a problem with your particular optics, 

but a characteristic of the lens design, which is a combination of 

unavoidable compromises. These aberrations are in general not very 

pretty to see, but fortunately there is a quite simple solution: close the 

aperture! However, now you may be asking: is it better to buy a Canon 

50mm F/1.2 for 1100 euros, that you have to close to F/2.8 to have 

sharpness in the corners, when you could just buy a Canon 50mm F/1.8 

for 120 euros, that for the same F2.8 value is practically the same? The 

answer is almost always no. In this case it is not better! It should, 

however, be remembered that faster lenses are not designed for the 

particulars (and demands) of night-time use. In general, they are used in order to have notable blurring effects in 

portrait photographs, and were designed for uses that are not judged on how the corners are rendered. Nevertheless, 

it should be pointed out that the recently designed optics often have a quality of image in the corners that is good 
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when the shutter is fully opened, thanks to their more modern and sophisticated technology. The costs are often rather 

high, but the quality they provide is decidedly elevated. 

So, to conclude the discussion on the regulation of the aperture, what we recommend is to close the shutter enough 

that the image at the edge of the optics will meet your expectations. 

The ISO. Another fundamental parameter to adjust 

with care is the ISO sensitivity. 

Increasing the ISO means electronically increasing 

the brightness in an artificial manner. 

This amplification is clearly not without cost, but it is 

paid in the quality of the details, the general grain of 

the image, the fullness of the colours and the 

softness in the shading. Recent reflex cameras have 

made considerable progress in this regard. Despite 

the increase in the number of pixels (which 

necessarily have become ever smaller and therefore 

less sensitive to light), their performance at high ISO 

is far better than in the past. Currently, taking shots with an FF reflex camera at 6400 ISO or an APS-C reflex camera 

at between 1600 and 3200 ISO provides notably interesting results, especially after careful post-production work. 

What I can recommend is that when evaluating the histogram, you set a value that is approximately with the top of the 

bell slightly skewed to the shadows. 

 

All graphics programs can display a histogram like that above. In Photoshop you simply press “ctrl + L”. Regardless, 

it is still a good idea not to exceed the above stated maximum ISO values since doing so would increase the 

brightness at the cost of greater noise (grain), which is more difficult to fix. Naturally, if you have a star tracker, you 

can lengthen the exposure time and still work at a lower ISO (generally between 400 and 1000 ISO) in order to obtain 

files that are clean and easier to work with. If you want to photograph the sky (with tracking) combined with the 

landscape (without tracking), I highly recommend using the same setting for time, ISO and aperture. Later we will see 

how this simplifies things in the elaboration phase during the fusion of the images. 

-FOCUS. The final aspect to check is the focus. The focus should be done in Manual Focus with the “Live-view” 

function activated. This function is now extremely common on more recent model reflex cameras. When framing 

a bright star at the centre of the image, it will be easy to verify the focus as it is when it achieves the smallest 
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dimensions possible. Forget about the ease of autofocus, which makes this operation so simple in the daytime. 

At night the light will never be enough to guarantee the reliable function of this convenient device. So you must get 

used to doing it manually, taking care not to touch the lenses' follow focuses in the later phases. 

Another thing which you absolutely must remember is to deactivate the image STABILIZER, if there is one on your 

lens. When the reflex camera is on its tripod, this mechanism could cause an effect opposite to the one it was 

designed for and create a movement that is seriously harmful to our images. 

And now? What do we aim at? 

At first glance, a clear dark sky can be daunting. There are thousands of stars, from the largest to the faintest. They 

can easily bewilder a less than expert observer. You must not get discouraged. Even without the advice of a friend 

with more experience than you, you will need very little to get your bearings among this myriad of bright dots. 

Furthermore, technology will help you, since smartphones are nearly ubiquitous and it is possible to install applications 

on them that can guide you and suggest the names of the stars or constellations we are observing. The most useful 

are indicated in the table below, divided according to the type of smartphone you have: 

 

Some examples of what we can do with a reflex camera mounted on a tripod 

If you wish to make a star trail around the North Star (which serves as a fulcrum around which the whole sky swivels, 

since it is located along the axis the Earth is spinning), you must aim to the north and take exposures for a total of at 

least one hour, split up into exposures of 2-5 minutes each. Aiming to the south will give you a different star trail, with 

stars arranged into lines that are almost parallel and together form concentric circles. This is because when facing 

south we are aiming towards the celestial equator, and therefore quite away from the centre of the sky's rotation. 

If you instead wish to record the figures of the constellations without any apparent movement, you must limit the 

exposure time according to the rules stated on page 4. Since you cannot make the time too long it is best to open the 

aperture as much as possible (so long as it is compatible with the corner sharpness of your optics) and raise the ISO 

to obtain a good exposure. 

If you want to shoot the Milky Way, you must first go to a site with a clear, dark sky, then aim the camera in the 

appropriate direction. This direction changes over the course of the year, so the suggestions of the planetary guides 

above may be of use. Usually, the brightest part of the Milky Way, the nucleus, is visible in the summer when facing 

SOUTH. The nucleus will never be very high above the horizon at the latitudes found in Italy, so you must be certain 

to have a horizon that is free of any obstacles that could impede your view. In the summer, the Milky Way is clearly 

visible above our heads, so you can photograph these areas as well, obviously forgoing including the earthly 

landscape in the frame, unless you create a mosaic of images. 

A few notes on “Dark-frame”, for the most expert among you 

At the end of the evening, perhaps as you are putting away your equipment, you can allow the reflex camera to shoot 

a few dark-frames. Many of you may have heard of this, but what is it exactly? The dark frame is a shot made with the 

same settings as our normal shots (the same exposure times and ISO, but also the same external temperature) taken 

with the lens cover in place. Naturally this provides almost black photos, but it is precisely that “almost” that makes 

the difference. Actually, each of the normal photos you take with those settings contains a real light signal that is laid 

over the underlying noise. This noise is caused by the characteristics of the camera itself, such as defective pixels or 

rings due to heat or electrical disturbances. This noise signal is almost invisible on normal shots, but is isolated in the 

“dark” pictures. In the elaboration phase, using the appropriate programs, it will be possible to “clean” your files using 

the information from these dark-frames. The operation can also be done manually with Photoshop, as we shall see 

later. Usually, dark frames are advantageous when using high ISOs (more than 800) and long exposure times (over 

30 seconds). Many reflex cameras have a function that automatically shoots a dark-frame after each shot, (so after a 

2 minute exposure, the camera will take another 2 minute dark-frame during which you must wait), in order to clean 

the noise caused by the shot just taken. 
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LANDSCAPE ASTROPHOTOGRAPHY –  ELABORATION 

by Cristian Fattinnanzi 

In this second section we provide the principal information needed to develop your astronomy pictures. 

The elaboration is fundamental, but remember that its primary scope is to eliminate the problems and defects linked to 

the presence of light pollution, to limit its disturbance and restore the visibility of the most subtle nuances of the sky. 

Making too many invasive interventions, such as excessive contrast or cartoon level saturation, may provide results 

that are appealing at first glance, but is often very far from reality and certainly subject to negative criticism from 

a technical point of view. Here, experience will be of great aid. If you have a doubt, it is always better to carry out more 

delicate interventions than those that the elaboration programs allow. 

Download your RAW files... and then what? 

You have come back from a wonderful session of night-time astronomy photography. Now, what is the most logical 

work flow to follow? First of all, download your files and archive them in an ordered manner on a safe support device 

(better yet, on two different support devices so that there is a backup in case of a problem on one of them). At this 

point, depending on what kind of photo you have taken, there are two different options. The main factor you must take 

into consideration is the number of photographs of the same subject that must be processed. If we have no more than 

3 or 4 shots of the same celestial subject we can carry out the entire process with Camera RAW and Photoshop. 

Beyond this number, or if there are dark-frames, we recommend using a specific and free program such as DSS 

(Deep Sky Stacker), or Iris (more complex but more effective). This guide describes how to elaborate photos with 

Photoshop and with DSS, as well as providing information on fusing photos of the sky and of the landscape for those 

who want to use photo montage to obtain landscape astronomy photographs. 

To start with, you should check whether your version of Photoshop can open the RAW files from the camera. If you 

have an up to date version of Photoshop and “Bridge” there should not be any problems. 

 

 
 

If instead your are unable to open the RAW files because your version of Photoshop is a bit out of date, you can 

download free Adobe “DNG converter” software to convert them into “DNG” (digital negative) format. This allows you 

to open RAW files even when using dated versions of Bridge and Camera RAW. 
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In Bridge (see above), you can select the images you want to process and open them by clicking on the shutter icon 

(Camera RAW). If all the images of the sky and landscape were taken with the same exposure times, ISO and 

aperture, then before starting the adjustments they should all be selected, by clicking on “Select all” on the top left, so 

that the adjustments are simultaneously applied to all the files. Then you can start to adjust the white balance and all 

the exposure parameters available in order to refine the files as much as possible. 

 

The end goal is to obtain a result that has no dominant colours and provides the best view of the image's details. The 

histograms on the top right will help you, since they show the colours that are lacking or in excess. 

 

Once this phase is completed, keep all the files selected, and press “Save images” on the bottom left and save all the 

images in PSD format, so that there will not be any compression and loss of information. 
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Let's work with Photoshop some more, on the alignment 

Once you have completed this phase of optimizing the files, you can see how to “sum up” (although more precisely it 

is an average) the images in order to further reduce the electronic noise and enrich the details. So open your files with 

Photoshop. If you have multiple files of the sky (tracked) and the ground (not tracked), you must calculate the sums 

separately, using the same procedure here below. 

-Open all the files. For example let's say there are 4 and they are called “A”, “B”, “C”, and “D”. 

Select and copy the content of “B” by using the menus to “Select>All” or by pressing “ctrl+a” and copying it 

with “ctrl+c”. Then close the “B” file without saving it. 

-Select the“A” file and paste it over the “B” file by pressing “ctrl+v”. In the layer settings, select the “difference” mode. 

In that mode you can align the two layers with the move command (V) by pressing “ctrl” and the arrow keys. The two 

layers will be aligned when the screen goes completely black. Once you have found the best position, go back to 

“normal” fusion mode and set the opacity level to 50%. 

-Select and copy the content of “C”, using the menus to “Select>All” or by pressing “ctrl+a” and copying it 

with “ctrl+c”. Then close the “C” file without saving it. 

-Select the“A” file and paste it over the “B” file by pressing “ctrl+v”. In the layer settings, select the “difference” mode. 

In that mode you can align this third layer with the move command (V) by pressing “ctrl” and the arrow keys. The layer 

will be aligned when the screen goes completely black. Once you have found the best position, go back to “normal” 

fusion mode and set the opacity layer to 33%. 

-Select and copy the content of “D”, using the menus to “Select>All” or by pressing “ctrl+a” and copying it 

with “ctrl+c”. Then close the “D” file without saving it. 

-Once again select the“A” file and paste it over the “D” file by pressing “ctrl+v”. In the layer settings, select the 

“difference” mode. In that mode you can align this fourth layer with the move command (V) by pressing “ctrl” and the 

arrow keys. The layer will be aligned when the screen goes completely black. Once you have found the best position, 

go back to “normal” fusion mode and set the opacity level to 25%. 

If there should happen to be a fifth layer, the 

percentage of opacity will be 100 divided by 5, so 

20%, and likewise for a possible sixth layer it should 

be set to 17%, for a seventh to 14%, for an eighth to 

12%, for a ninth to 11% and for a tenth to 10%. 

So, to summarize, the sequence of opacity is: 

100%, 50%, 33%, 25%, 20%, 17%, 14%, 12%, 11%, 

and then 10%. 

Beyond 10 images I recommend using more specific 

programs, such as the above mentioned DSS, which 

also allow you to elaborate dark-frames and flat-fields. 

Once aligned and all the layers have the 

right opacity, set the dynamic to 16 bit so 

that the image can be saved and contains 

the greatest amount of information due to 

its multiple layers. 

The command is reached through the 

following path: 

“Images>Mode>16 Bit/Channel”. 

At this point you can bring together all the 

selected layers (Layer>Single layer) and 

save this file as “Master”, since it contains 

all the information from our shots. 
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This procedure to achieve an average of 

the photograms may be intricate and a bit 

boring to carry out, but it is fundamental for 

reducing the noise and grain in the image. 

Its function is simple enough to explain. 

Grain appears substantially as a casual 

sequence of luminous irregularity in the 

pixels that is overlaid with the “good” light 

signal from the subject. When the 

percentage of the various layers is entered, 

the “good” signal is confirmed (and remains 

intact) while the noise is displayed at 50%, 

33%, 25%, etc. every time another layer is 

added. A file obtained with many shots 

therefore has less grain. This means you 

can elaborate it with greater use of the 

Photoshop filters without the anti-aesthetic 

amplification of the electronic noise that is 

typical of images taken at above 800 ISO. 

Another advantage, although it is 

secondary and less salient, of the average 

is the improvement of the stars' aspect. 

This is because the law of probability means you will have stars that are more rounded and aesthetically pleasing 

(except if there are periodic tracking problems and optical aberrations). 

 

Finally! Let's elaborate the files 

You made it! You finally have your files ready to be optimized! Personally, I recommend always working on 

duplicated layers (ctrl>J), in order to be able to partialise the interventions, if the result is not desired throughout the 

image. This “partialisation” is carried out by adjusting the opacity of the layer, or by using the gradient erase tool, or 

working with more developed layer masks that can be reached through “Layer>Layer Mask>Show all”. These means 

allow you to have a separate layer with your intervention that can then be joined to the starting layer at any time. The 

first command to balance the image might be “Image>Adjustment>layers”, and then you can slide the cursor to 

achieve the correct overall luminosity. Sliding the cursor to black (on the left) makes it possible to significantly limit the 

glare caused by light pollution. 

  

You must never overdo it and attempt to be delicate. If you allow yourself to rush or lose control of the instrument's 

power it can lead to the generation of an unnatural appearance that is not pleasant to look at. Always keep the 

background sky under control and never let it become completely black. If it does, you have probably sacrificed a few 

weak nebulas to the darkness. 
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Adjust the general colour of the image 

After this intervention there may be some irregular colour dominance. A command which may surprise you in this 

regard is “Image>Automatic colour” (Shift+Ctrl+B). In the most difficult case you can use 

“Image>Adjustments>Substitute colours”, or “Selective Colour Correction” or “Colour balance”. Do not ever forget to 

always work on duplicated layers, in order to optimize the areas and the nature of the intervention. 

 

Often after these adjustments in luminosity and colour, there is a risk that the contrast is slightly emphasised, with 

excess light and shadow, and this takes away from the mid tones that usually contain the most interesting subtleties. 

A command that can help with this is the adjustment of “Lights and Shadows”. Used in a measured manner this 

command can restore a lot of interesting information. 

 

A new optimization of the colours may be necessary, which you can carry out as described earlier. For example, you 

may notice slight dark green coloured halos at the sides of the nebulas. The command best suited to eliminating them 

is “Image>adjustments>Substitute colour” (the following figure): you must select the colour to be treated (by 

clicking on it), adjust the extension of the selected area with the “Tolerance” slide cursor and lower the available 

gauges to obtain the desired effect. Usually it suffices to remove saturation, but it is good to know that you can use all 

the slide gauges available. This command is very useful in wide field photos as well, where there are often halos or 

bothersome zones of luminosity on the horizon caused by light pollution. 
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The reduction of noise 

All of these operations almost always end up providing an image that is good with regard to the chromatic and 

luminosity point of view, but rather poor with regard to the grain profile. The problem is not due to your error, but rather 

that you are “squeezing” the collected light signal, which inevitably causes the effects to be brought out as well. The 

solution may be to shoot more photos of the object in the shooting phase, but this is not always possible, especially if 

you are already elaborating the image! Photoshop offers optimal noise reduction options, but you must also use them 

with the proper care. Often the noise is concentrated in the darkest zones of the image, so we must use targeted 

processing. My advice is to create a layer mask that contains the dark zones of the image, and apply it to the layer 

that has been subject to robust noise reduction. Let's look at the steps: 

-Create a “Noise reduction” overlay layer by duplicating the latest state of the image (be careful with the opacity of the 

layers. If the last layer is not complete join those necessary to obtain a full image). 

-Apply the noise/disturbance reduction filter (Filter>Noise>Reduce Noise…) 
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-On this layer, create a layer mask using the “Hide all” option. 

 

-Now turn off the display of this layer and go back to the one below where you started, “Sky Colour”, and select all 

(ctrl>A), and copy it (ctrl>C). 

-Turn the eye back on and click to select on the “Noise Reduction” layer. Then hold down the “Alt” key and click on the 

black box of the layer mask. 

-This brings you to the layer mask and by using “ctrl>v” you paste the previously copied image on it. The image will 

appear in black and white. It allows the signal to pass in the white areas, while it does not in the black areas. Since 

what you need is the contrary, that the layers with the disturbance reduction act on the dark tones of the background 

sky, you must invert them to negative. Just click on the mask icon and press “ctrl>i”. 

 

-At this point it will probably be necessary to deselect the image (by pressing “ctrl>d” you deselect all), and turning the 

layers view back on by clicking the eye on the top layer. If you enlarge it quite a bit, you will then notice how the filter 

has adjusted the dark areas alone. To accentuate this effect, you can intervene on the layer mask. If you click it you 

can regulate its layers in order to make the background sky white and the parts in question grey/black. If the noise 

reduction operation is still insufficient, you can continue applying other filters, such as a “blur” or even another “reduce 

noise”, making sure to apply it to the “noise reduction” image and not the layer mask. 
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-Whenever it might be necessary, you can 

exclude or include certain zones from/in 

an operation by clicking on the layer mask 

and using smudge brush and reduced 

opacity (usually 50% works well) in white 

to accentuate the reduce noise effect, or 

in black to reduce the effect. 

If you have reached a good point in the 

elaboration you can bring together the 

layers you have created, except for the 

one you started from. To do so just turn 

off the small eye for the “Background” 

layer, select one of the working layers and use the “Layers>Join views” command. This way you can also compare 

them, by clicking the little view eye on your result to see what you have achieved as compared to the starting image, 

the “Background” layer. 

The contrast mask 

The “Filter>Contrast>Contrast Mask” filter allows you to contrast image details that are more or less large. Likewise, in 
this case it is best to work on a duplicated layer in order to manage the result and possibly exclude areas where the 
intervention would not bring about an improvement. The filters can be adjusted using 3 parameters: 

-The Factor basically regulates the nature of the intervention and how much strength you wish to assign to the mask. 

-The Range is used to set the size of the elements highlighted. If you wish to emphasize the fine micro-contrast you 
must set very low values, typically between 0.5 and 3 pixels, while if you instead wish to have a general contrast to a 
wider range of elements, you must set higher values, of 15 and up. 

-The Threshold allows you to progressively exclude dark areas from the operation, as these areas would usually 
show image grain. Personally, I almost always keep it at “1”, but every individual will have his or her own needs. 

 

A problem that the contrast mask often generates is “burning” (that is, making too white) the lighter areas, including 
the brightest stars, so that they tend to spread out in a way that is not aesthetically gratifying. This characteristic 
usually makes the image less pleasant, but you must evaluate it on a case by case basis. There are many ways to 
avoid this problem. The two main solutions are to generate a layer mask that excludes the lights (as seen above for 
the reduction of noise), or, more simply, by using the “Select>Colour interval”. Then select a white point and adjust the 
“Tolerance”, improve the selection with “Select>Modify” “Expand” (usually 3-4 pixels) and “Blur” (usually 2-3 pixels) 
and then cancel it. 
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How to reduce the diameter of the stars 

Often the elaboration of the image causes an increase in the stars' diameters. In many cases this makes the picture 
appear unnatural, as though they had been painted on. You can use Photoshop to reduce their diameters, thanks to 
the “Minimum” filter. As before, create a duplicate layer and use the tool bar to “Select>Colour interval”. Then you can 
use the dropper to touch up the white coloured details. Photoshop will select everything in the photo that is white, such 
as the stars you are trying to fix. Adjust the tolerance to select the number and intensity of the stars you want to treat 
and then hit OK. Then use the tool bar to: 

SELECT > MODIFY > EXPAND then enter 4 pixels and hit OK. 

SELECT > MODIFY > BLUR then enter 2 pixels and hit OK. 

This way we select not only the saturated nuclei of the stars but also the area immediately surrounding the stars, all of 
which will be affected by the filter. The blur command makes the action appear less aggressive along the edge of the 
selected area. 

Then apply the minimum filter. Using the bar click: 

FILTER > OTHER > MINIMUM 

Set the range to 1 pixel and hit OK. Right away, you will see the stars' diameters have decreased. At this point, if the 
filter is too much, you can “mitigate” the filter action by going to: 

MODIFY > DISSOLVE MINIMUM 

Then use the cursor to set the percentage to your liking. 

If the stars are still excessively dilated, repeat the operation again with another application of the filter and another 
dissolve. 

Do not ever forget that each passage of these two operations may need to be “masked” since the intervention is not 
always advantageous on all pictures. The layer masks can also generate gradients. The “Gradient” icon in Photoshop 
is together with the bucket, and can also be selected by pressing the “G” key. This will provide a very gradual 
partialisation of the layer view that is practically imperceptible if properly placed. These graduated masks are often 
used in the wide angle photos in order to make the typical light along the horizon uniform. 

The final touches 

Finally, you can give a bit of colour contrast to the image by using the “Vibrance” (available in Photoshop CS5 and 
later versions), “Saturation”, “Luminosity and Contrast”, “Curve”, and “Selective colour correction” commands. 

If you have also taken dark-frames 

Photoshop also allows you to perform Dark-frame subtraction procedures, so long as they are done with certain 
care. Remember that dark-frames must be taken exactly as the shots of your subject except that the lens cap is on. 
That means they must still have the same exposure time, ISO and be taken with the same external temperature. You 
must also be certain to cover not only the front lens but also the rear lens of the camera's viewfinder. For more reliable 
dark-frames, you can take a number of shots. 3 to 10 shots usually guarantees good results. Let's see how we can 
actually use them. First of all, the dark-frames must be subtracted BEFORE performing any other operation on the 
images in Bridge or Camera RAW. This is because the signal you are treating needs to be the one recorded by the 
reflex camera. If you have taken multiple dark-frames, you can get the average of them using the same method as we 
saw above for normal images. Having done this you will obtain a single file that you can call “Master-Dark”. This file 
must be copied and pasted on each image taken and then the fusion method for the layer must be set to “Difference”. 
That way the random recurrent signal that appears in all the images will be subtracted and your shots will come 
through cleaner. It should however be noted that in some cases the subtraction of the dark-frames could be 
excessively invasive and generate black pixels in light areas of the image. This problem can then be limited by 
reducing the opacity of the dark-frame level to a value near 50%. This makes the dark-frame less effective but the 
problem will be far less evident. Once the dark frame has been applied to all the images and they are saved under a 
new name, you can begin the processing of the images described on page “7”. Personally, I can say that in the most 
recent reflex cameras, the noise in the sensor is far more contained and the advantages offered by dark-frames are 
less significant than they were in the past. Whenever you do choose to use them, Photoshop is certainly not the best 
program to apply them. That is why I recommend using specific programs designed for the processing of astronomy 
pictures, such as the above mentioned DSS. 
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Techniques and commands useful for landscape astrophotography 

Up until now we have described elaboration techniques 

specific to astronomy photography, which may nevertheless 

be useful for any night-time photographs with the subjects in 

low light conditions. However, astrophotography with long 

focal lengths (greater than 300 mm) requires expensive and 

heavy equipment, such as motorised equatorial mounting 

suited to supporting and moving heavy telephoto lenses or 

telescopes with precision, parallel tracking scopes, and 

large power sources to provide electricity for everything. 

For those just starting out, this may be a bit of a risky 

choice. Investing in equipment is very expensive and then 

you may discover that long focal length astrophotography is 

too demanding and not your cup of tea. This would mean 

suffering useless expenses and losing a large part of the 

money even if you are able to resell the material on the 

second-hand market. 

The best thing is to start by using very short lenses, a digital camera with sensors of at least APS-C (22x15 mm) 

and a solid tripod. Smaller sensors collect less light and are clearly not ideal for night-time photography. For the same 

reason fast lenses are preferable, at least F4 or better yet F2.8, with short focal lengths, somewhere below 28 mm on 

FF format (18 mm on APS-C format). This will allow you to lengthen the exposure time up to at least 10-15 seconds 

before any motion due to the Earth's rotation is shown. 

With this kind of wide angle shot, you can better make your astrophotography more interesting by placing the shots 

within a context by including elements of the landscape, especially when these elements are aesthetically pleasing or 

particularly characteristic. Including landscape means you must choose from among three different photographic 

techniques, that affect both the amount of processing and the equipment needed: 

-SINGLE fixed photo, on a tripod, taking one shot for the sky and landscape, with an exposure limited by the 

“300 divided by the focal length = seconds” rule to avoid the stars' movement and generally high ISO sensitivity, 

above 1600 (more often between 3200 and 6400). 

-DOUBLE photo on a tripod but taking two shots, one of the sky with a limited time and high ISO, and another of the 

landscape with less extreme settings to avoid grain (at least in the terrestrial part). In this case photo montage will be 

required to join the two images together to achieve a single picture, in which, unfortunately, there is no way to avoid the 

difference in quality between the earthly and celestial parts given the much higher ISO of the latter. When taking the shot it 

would be a good idea to calculate the times (for example, 30 seconds at 3200 ISO for the sky and 2 minutes at 800 ISO for 

the landscape) so that there is the same exposure for both shots and in order to simplify the fusion in the elaboration phase. 

-TRACKED DOUBLE: in this case you will need a star tracker that, when mounted on the tripod, will allow you to 

lengthen the exposure times for the photograph of the 

celestial part as well. Then you can work with a mid range 

ISO, typically between 400 and 1000 ISO, and obtain files 

that are far cleaner, more detailed and easier to elaborate. 

With this technique it is also advisable to keep the same 

exposure time for the ground and sky parts of the picture in 

order to simplify the delicate work in the elaboration phase 

and the union of the photographs. You should take the 

photos of the sky with the tracker running and the photo of 

the landscape is obviously done with the tracker turned off. 

Since it runs using a clockwork mechanism, the Minitrack in 

particular only stops moving when it has run through its 

charge. The best procedure to use is first to mount it and aim 

at the North star, and then: 

-with the timer fully unwound, compose the frame so that the desired earthbound elements are in place; 

-wind the timer to the time needed to take the exposure you want of the sky (such as 15 minutes if you want to take 

3 exposures of 4 minutes with a 1 minute break between them) and start a sequence of at least 7-8 exposures. 

That way, the tracking will guarantee the 3 shots of the sky and then the camera will take 3-4 shots of the ground with 

the timer already out of charge. 
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Now let's look at how to carry out the elaboration of the two separate images (one tracked) in order to obtain a single 

picture in which neither the sky nor the ground images show movement. 

Convert all the files and treat them using “Bridge” and “Camera RAW” as described above. Be careful to carry out 

exactly the same adjustments on all the files used to make up the image. 

Then, if you have taken multiple shots of the tracked sky, it would be best to make an average as described above. 

It is true that working below 1000 ISO may not require you to take more shots, but if you are able to and the 

conformation of the horizon is favourable (without any trees, poles or large irregularities that could create problems in 

the fusion phase), it is not a bad idea to take 2 or 3 shots to average both the sky and the ground. This is especially 

true when the ground is substantially less luminous than the upper part. Another reason to take multiple shots is as 

a safeguard against unforeseen problems. If something happens to go wrong in a shot (movement in the image, the 

tripod being bumped, an aeroplane going by, undesired light in the frame, etc.), we can always discard the bad shot. 

Once you have obtained two “Masters” (of the Sky and of the Earth), you can follow the directions shown in the 

images below in order to ensure the areas in which they meet are indistinguishable. 

------------------------------- 

ELIMINATE the stars along the horizon with the "stamp-clone" tool for a band along the horizon. This operation is 

fundamental for "cleaning up" the "crossing" zone between the NO-TRACKED image and the TRACKED image. 

 

PASTE the TRACKED Sky image above the one NOT TRACKED about panorama with the stars cancelled along the 

horizon. 
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NOW, SET the sky level to "DIFFERENCE", in this way, with the command ("V") and with the directional arrows we 

can better align the two images. 

 

ALIGNMENT: we will realize that the images are well aligned when, along the horizon, we will have less light areas 

("different" zones indeed!) 

 

SHADING: once align the images, reset the top layer with "normal" fusion method and with a "brush" shaped rubber, 

0% hardness and adequate diameter, we start to cancel the boundary line between sky and earth. 
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CANCELLATION: 

obviously, once the part of "crossing" between the two images is blurred, we will eliminate from the level of the traced 

sky, even everything that is underneath and that is displaced. 

 

 

FINAL FUSION! 

To conclude, all you need to do is merge the layers together and cut out the outlines that do not contain both images 

after alignment. The final processing will follow to balance colors, brightness, reduce noise, etc. 

 

 

In the sequence just detailed the eraser is used to delete the part with movement. The same result can also be 

achieved with a layer mask, which also allows you to correct the selection at any time. Once these steps to align and 

fuse the two images have been carried out, join the layers and save the image as “Union”. Then you can of course 

begin to elaborate that file with the techniques described above. 

 

Here below are some examples of images achieved with this technique: 

The star tracker used for these pictures is the clockwork driven Minitrack-LX. The previews are small in dimension, 

but despite this, it is possible to notice the points of the stars and the clean tones and colours that you would not have 

expected from the ISO used. 
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For any information or clarification of any of the subjects addressed, you can contact me through Facebook, by 

searching for Cristian Fattinnanzi, or join the “Minitrack LX” Facebook group that I created to discuss and collect 

images made with this star tracker that I designed and built by hand. 

The group also publishes announcements regarding events and conferences on astronomy photography organised so 

that we can meet under the best skies Italy has to offer. There, in good company, we photograph and practice this 

wonderful passion for astrophotography! 

Recommendations for successful night-time photography. What equipment do you need? What settings should you 
use? What precautions should be taken? Find out the answers in these 10 suggestions. 

1. USE MANUAL MODE 

Manual is the most suitable mode because it allows you to make a series of attempts in your approach to the final 
result rather than having to try to interpret the values proposed by the automatic mechanism of the shot. Furthermore 
you have the possibility to use the B setting for times lasting over 30 seconds. 
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2. DELETE THE INTERRUPTIONS 

Many different things can happen during a long exposure. People can stand in front of the camera. Headlights from 
buses and cars flash by. If you are trying to shoot in Bulb exposure, cover the lens (using a black card) until they have 
passed and then continue the exposure. 

3. COMPENSATE FOR LIGHT SOURCES 

Very intense lights on the scene can trick your camera's light meter and lead to underexposure. So, when shooting in 
manual, keep in mind that the correct exposure values may be different than those suggested by the camera. When 
shooting in automatic you should make use of the exposure compensation. 

4. THE B SETTING (BULB EXPOSURE) ALSO EXISTS 

The time for long exposure shots does not necessarily need to be very precise. If the typical maximum value of 
30 seconds is insufficient, in manual mode we can then use the B setting. The shutter will remain open so long as the 
shutter release is held down. That way you can easily measure the exposure time using your watch. 

5. FIND A FLAT SURFACE 

What do you do if you don't have your tripod with you? Find a flat, stable surface where you can put your camera, then 
use the self timer and do not touch the camera while it is taking the shot to prevent any vibration. 

6. GET THE CORRECT COLOURS 

At night you often end up shooting with a great variety of light sources, and so it is almost impossible to find the 
correct White balance. Under such conditions the Auto setting often provides the best compromise, but it can be 
useful to shoot in RAW format in order to attempt to modify the White balance settings. 

7. BRING A TORCH WITH YOU 

Always bring a torch when you go out to photograph at night. It will help you set up the equipment correctly. Also you 
can use its light to “paint” your subject. You'd be surprised. At night a tiny light can produce grand results. 

8. USE THE MIRROR LOCK-UP 

The D700, and the D300s, as well as all the Nikon FX have a mirror lock up (MLU, a.k.a MUP- Mirror UP) function that 
comes up before the shot is taken. The vibrations of its movement can dampen prior to the first shot, thus limiting the 
chances of mini-movements in the image. It should also be said that the longer the exposure times are, the less 
evident the loss of sharpness caused by the mirror's vibration. 

9. A FRIEND ALWAYS COMES IN HANDY 

Photographing at night means heading out with a great deal of rather expensive equipment. Going together with 
a friend not only means greater safety, but also provides two extra hands that can hold a torch, a flash, or anything 
else you might need. 

10. WHAT ISO SHOULD I SET? 

The adjustment of the ISO value on reflex digital cameras is extremely useful for night-time pictures because it allows 
you to customise the camera's sensitivity to the level of illumination present. 
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7 techniques to shoot breathtaking night-time photographs 

 

 

Shoot beautiful photos that are still recognizable even if transformed by nocturnal light. 

When the golden light of the sun sets and makes way for darkness, many photographers put their equipment away and head 
home. For some, instead, it is only the beginning. The landscape transforms at night and common place, familiar scenes become 
unusual. This offers many unique photographic opportunities. 

Thanks to technology's unstoppable march forward it is now possible to take photos in every situation, from the brilliant lights of the 
city to the darkness of the night sky. Cameras can be pushed to work with extreme ISO sensitivity in order to capture details even 
in the darkest of scenes. In this article you will discover 7 techniques to shoot breathtaking night-time photographs, from 

fantastic panoramic views of the Milky Way to the timeless Star-Trail, from urban landscapes to the creative Light Painting 
technique using a torch. You will also learn to control the depth of field in order to create fascinating photos with sharp close-ups 
with wonderfully out of focus backgrounds. 

Astrophotography is undoubtedly the most fascinating of photographic genres. Many of the techniques here addressed require 

experience and a massive dose of patience, but in the end you will realize that your efforts will be rewarded, because the pictures 
you get will add value to your portfolio. Continue reading and you will understand that as soon as you are out your door, there is 
a world to discover and you will learn the best way to use your equipment to do just that. Good light, even if there is not much of it! 

Photographing at night, even for an expert photographer, opens up a new world of possibilities. Dedicating a little bit of time to 
prepare your equipment and study techniques will give you a greater chance of obtaining wonderful photographs. Here are some 
things you need to know to be able to safely shoot fantastic photos. 

http://i0.wp.com/www.reflex-mania.com/wp-content/uploads/2015/06/milky-way-chideock-seatown-by-Stephen-Banks.jpg?fit=1500,1064
http://i0.wp.com/www.reflex-mania.com/wp-content/uploads/2015/06/milky-way-chideock-seatown-by-Stephen-Banks.jpg?fit=1500,1064


23 

 

 

As ever, planning is fundamental. There are instruments that allow you to schedule your photographic outings ahead of time. 
Google Earth will help you find the right sites, while on Flickr you can see how your colleagues framed a particular scene. If you 
want to photograph the dome of the sky applications such as PhotoPills or Stellarium are useful since they provide information on 
when certain heavenly bodies will be in a specific position. Another equally important task for getting beautiful pictures of the stars 
is evaluating the impact of light pollution. It is often necessary to walk for a long time in sparsely inhabited areas in order to find 

a location from which you can successfully photograph the night sky. Scout sites out and be careful of even the smallest flashes on 
the horizon, since these can become extremely invasive with the long times needed for the correct exposure of the sky. 

The search for dark skies is ever more difficult and may require a great deal of time, even in areas that have been classified as 
ideal for night-time photography. Also keep in mind that the Milky Way is most visible in the summer, while in the winter it nearly 

disappears from the sky. Alternatively, cities offer infinite possibilities to take nocturnal photos! Look for a scene with interesting 
elements and use the lines and shapes of the architecture to guide the observer's eyes. Once you have located an area at night, it 
is important to visit during the day to find out whether it can be accessed without problems. Make sure to find a route in and out that 
is safe when it is dark and always be certain to tell someone where you are planning to go and what time you expect to be back. 

Take several different shots of the elements of interest in the preparatory outings and study the compositions of your photos. That 
way it will then be far easier to shoot when you return when it is dark. Remember that while a photo of the Milky Way alone can be 
fascinating and pleasant, if you put in elements that are recognizable in the foreground the viewer becomes more involved in the 

picture. It is also important to balance the rapport between the foreground and the sky well so that there are not any elements that 
would create distractions in the final image. 

On thing you must consider carefully when planning a night-time outing is your clothing. Choose heavy clothes because staying 

outside 2 or 3 hours at night can become dramatic if you are not properly covered, even if the day was quite warm. Your shoes are 
also very important. Their soles must have a tread suited to damp and slippery ground and the shoes must be water-proof. 

While a good torch is fundamental, it is just as important to use it properly. Avoid pointing at anybody you see in the distance, who 
might be another photographer who is trying to take an exposure at that moment and you would then ruin his or her photo! Also 
make sure your mobile phone has coverage in the area you are headed, as they are always useful if there happen to be any 
problems. 

https://www.google.it/intl/it/earth/
https://www.flickr.com/
https://geo.itunes.apple.com/app/photopills/id596026805?mt=8
https://geo.itunes.apple.com/app/stellarium-mobile-sky-map/id643165438?mt=8
https://www.amazon.it/s/ref=as_li_ss_tl?_encoding=UTF8&field-keywords=torcia&linkCode=ur2&tag=reflexmani048-21&url=search-alias=aps
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Now we come to photographic equipment! Speaking of cameras, we must say that models such as the Nikon D4S or the Canon 

EOS-1D X are the best for night-time photography, but these are professional cameras and not within the grasp of everyone's 
budget. Fortunately, technological progress means that even the less expensive reflex models are able to provide optimal results in 
the management of noise due to their high ISO. With the right lens you can start to capture the intrinsic details of the Milky way, 
even if you use simple settings on your reflex camera. 

It almost goes without saying that night-time photography requires a tripod and you can find different kinds available on the market, 

even lighter ones that allow you to move about with greater ease. It is important that it is stable enough to resist the night-time 
winds, since being out at night when the mistral wind is blowing is not at all pleasant. To increase the tripod's stability you can use a 
number of tricks, such as attaching a weight to the central column. You can even use your photographer's backpack to do this. 
Another trick is to ensure the tripod's feet are on solid ground rather than something less stable like ice, mud or sand. 

Once you have found the location and organised the equipment it is now time to consider the setting your will use for the photos 
you want. The first thing to do is set the photos in RAW format. Cameras with a good dynamic range allow you recover details 

from lights that are too bright, from underexposed shadows and the luminosity that may not be apparent from the Milky Way by 
using touch up software. 

The second thing is to always remember to work in Manual mode, since you cannot trust the light readings for a night-time 

photograph taken with the camera. Start by choosing conservative options, especially in scenes where there are points of bright 
light. 

Keep the ISO low when in the city. If you must make a photo more luminous, lengthen the exposure time or open the aperture. 
If you want to photograph an urban landscape use a remote shutter release so that you can set times above 30 seconds without 
being forced to manually hold the shutter release button down the entire time. Try different exposure times to see what effect they 
have on elements in movement. 

Many countryside locations have very little light, especially in the very early morning. Rather than avoiding shooting during these 
hours take advantage of the darkness to photograph stars that are not yet hidden by the sun's light. Do not be afraid to use 

more extreme settings, such as an ISO of 3200 or 6400, especially since the newer models of reflex cameras have made great 
strides in this field. In any case photos taken with high ISO will be grainier than those with lower ISO sensitivity. While grain is by no 
means the end of the world, many photographers try to avoid it at all costs. If you like you can even choose lenses with large 
apertures and use rather long exposure times. However, to obtain sharp photos of the Milky Way you will have to invest quite a lot 
of money in equipment. 

On the other hand, Long exposures cause the appearance of thermal noise and hot pixels. Thermal noise is really tough to get 

rid of even in the touch up phase. The reduction of the camera's level of noise can interfere with the rhythm of the shots, since it 

http://www.amazon.it/gp/product/B00KDJBMOG/ref=as_li_ss_tl?ie=UTF8&creativeASIN=B00KDJBMOG&linkCode=as2&tag=reflexmani048-21
http://www.amazon.it/s/ref=as_li_ss_tl?_encoding=UTF8&field-keywords=Canon%20EOS-1D%20X&linkCode=ur2&tag=reflexmani048-21&url=node=473538031
http://www.amazon.it/s/ref=as_li_ss_tl?_encoding=UTF8&field-keywords=Canon%20EOS-1D%20X&linkCode=ur2&tag=reflexmani048-21&url=node=473538031
http://www.amazon.it/s/ref=as_li_ss_tl?_encoding=UTF8&bbn=435505031&fst=as:off&linkCode=ur2&qid=1434710334&rh=n:412609031,n:!412610031,n:435505031,n:473557031&rnid=435505031&tag=reflexmani048-21
http://www.amazon.it/s/ref=as_li_ss_tl?_encoding=UTF8&field-keywords=&linkCode=ur2&rh=n:412609031,n:435505031,n:473391031,n:473410031,n:4175434031&tag=reflexmani048-21&url=node=4175434031
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requires a period of time in which the camera cannot be used for taking photographs. Alternatively, you can take a shot with the 
lens cap on but with the same setting as the shot with hot pixels and then eliminate them with the appropriate software. 

 

It is worth mentioning that when you use long exposure times, the Earth's rotation will cause relative movement of the stars in the 
picture and subsequently they will create trails of light. To take a sharp photo of the Milky Way you can use the rule of 500, 

which allows you to establish the maximum exposure time for each lens you are using. Divide 500 by the focal length you want to 
use and the result is the exposure time. With a 50 mm full-frame lens mounted on your camera you can use an exposure time of 
10 seconds. If you have an APS-C reflex camera then use a factor of 1.6x for the focal length and you get 500/(50×1.6)=6.25. 

Another option is to acquire a star tracker that makes the camera follow along with the movement of the stars. This device will 

enable you to use much longer exposure times with more restrained ISO sensitivity. On the downside, the foreground of the earthly 
elements will show movement and you will have to fuse together two images, one for the stars made with the star tracker, and 
another without it in order to have a nice sharp foreground. 

To have the stars in focus you must manually focus at infinity or better yet the sideways infinity symbol before the infinity symbol in 
the lens distance window. In any case, always check the photos right after they are taken and make any necessary changes to the 
settings. If you are unable to capture a satisfactory portion of the sky in a single photogram with the lenses you have available, try 
to shoot a series of photos that you can later bring together into a single picture in the post-processing phase. In Photoshop you 
can use the Panorama Photomerge command. 

Once you get home you must convert the pictures into RAW files. Using a program such as Adobe Lightroom 5 you can selectively 
apply improvements and work on specific areas of the photo. This technique is extremely useful when you have to increase the 
luminosity of the Milky Way or the luminosity of the landscape illuminated by the light of the stars. Making many little local 
modifications make it possible to make many little details of the starry sky become clear. 

Photographing at night is a challenge, but it can become an addiction when you start getting valid results. The more time you 

spend out photographing the stars, the greater the chance you will have of capturing something truly special, such as a comet for 
example. Once you have learned the basic techniques, it will be your own instinct that leads you to the best conditions and 
locations for shots that will leave you speechless! 

http://www.amazon.it/gp/product/B00DBRPMIE/ref=as_li_ss_tl?ie=UTF8&creativeASIN=B00DBRPMIE&linkCode=as2&tag=reflexmani048-21
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1. LIGHT PAINTING 

Discover what you can do with a torch to make the details of a night-time scene come alive. 

 

Your electric torch can do more than just light your way from the car to where you are taking your pictures. It can also be used in 
the taking of the photos themselves! With certain cameras you will be able to photograph the Milky Way so well the foreground 
becomes nothing more than a silhouette. 

Set the self-timer and approach the elements you want to light up. When you hear the shutter point the torch at these elements and 
move the light beam in a regular and uniform manner without letting it stop in any one point for too long. Try not to have the torch 
on when you are near the camera to avoid creating reflections on the lens. It is not easy to get the right lighting and you will have to 
make several attempts before you get the perfect shot. 
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2. INCLUDE THE MOON 

Make sure you expose the moon correctly in order to create a truly compelling composition.

 

 Photographing a landscape with the moon is not simple. Creating a portrait of the moon in a serene sky is just as complicated as 
photographing the sun. With the expositions used for normal night-time photography you will have a moon that is definitely over-
exposed. The best solution is to shoot multiple photos, in which one shows the details of the moon clearly, another shows the 
elements on the ground correctly, and yet another for the rest of the sky. With photo touch up software you will then have to join the 
three photos together to create a single picture in which they are all exposed and can be perceived perfectly. 

During its orbit around the sun, the moon will reflect different amounts of sunlight due to the shadow or our planet. You can find out 
the phases of the moon using apps, such as MoonPhase, for iOS operating systems, or MoonPhase Widget, for Android. 

https://geo.itunes.apple.com/app/moonphase-moon-info/id287526650?mt=8
https://play.google.com/store/apps/details?id=com.mlst.moonphase
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3. MILKY WAY PANORAMA 

Space in the celestial sphere. 

 

In order to photograph the Milky Way you need specific settings. The exposure time must be short enough to prevent the Earth's 
rotation form showing the stars in movement. The ISO must be high enough to capture the light from the stars and the lens must 
have a distance window. The photographer, Bill Shupp, suggests planning the outing carefully: “Study the position of the Milky Way 
ahead of time and choose the location based on that data. Always try to get something interesting in the foreground to create a 
support for the starry sky. This may be the most important thing”. 

Shooting a panorama of the Milky Way is the next step. With an 18mm wide angle lens mounted on a full frame, shoot vertically to 
get five photographs of the galaxy. Once you have downloaded them to a computer, use a retouch program, such as Photomerge 
by Photoshop, to bring the various shots into a single breathtaking panoramic image. 

4. STAR-TRAIL 

Take advantage of the Earth's rotation to photograph the stars and create fantastic trails across the sky. 
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In photography, Star-Trails are the representation of the stars' “movement”. The Earth rotates on its axis at a set speed and for this 

reason the heavenly bodies, that are actually still, appear to move across the sky when photographed with somewhat longer 
exposure times. 

The longer the exposure is the longer the trails created by the apparent movement of the celestial subjects. However, these photos 
will also record the effects of any other lights that appear in the photo. The solution to this problem is to perform a series of brief 
exposures. For this technique you will need to use an intervalometer, which will allow you to set how often it should take a 
photograph. 

Once the photos have been downloaded you can unite them into an image with layers, using an appropriate program.  

CAPTURE MOVEMENT 

 SETTING THE INTERVALOMETER 

When setting the intervals between one shot and the next, remember to calculate the time in which the camera is inactive which are 
needed for the elaboration of each file so that you do not create gaps in the trails. 

 SHOOT THE PHOTOS 

Over the course of a couple of hours you will have enough photos to create a valid Star-Trail. Make sure you have somewhere 
warm to stay during this period or clothing that is warm and suited to the environment! 

 STACK THE IMAGES UP 

If you have Photoshop then you can use the File > Script > Load images in series command, otherwise try Startrails.de, which is a 
simple program free of charge. 

http://www.startrails.de/
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5. LIGHTS BOKEH 

Highlight subjects in the photo by creatively placing the background lights out of focus.

 

You can give your night-time photos a dreamy quality by creating bokeh in which the lights are turned into luminous coloured 
spheres. While generally expensive, high quality lenses have the advantage of having a fantastic ability to manage out of focus 
elements, which photographers refer to with the term bokeh. 

Approach the subject with the camera so that the points of light in the background are arranged around it. Set the aperture open so 
that the background is completely out of focus and the lights are turned into glowing, pleasantly coloured bulbs. 

Lenses with wide apertures, in addition to creating a bokeh, can be used with faster times in night-time shots so that there is a 
decreased risk of blurring. 
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6. CITY LIGHTS 

It is difficult to see stars in the sky while in the city, but you can take advantage of the urban lights for beautiful night-time 
photographs. 

 

From sunset to sunlight, cities are enriched with artificial lights. From the glow shining out of windows to the harsh street lights, 
there is always the possibility for photographers to take interesting nocturnal photographs in the city. Furthermore, the real 
night owls can take advantage of the rare empty streets and squares and immortalise the scene without having to worry about 
passers-by. 

Today's urban landscape is modified by the night-time atmosphere and the colours are changed by artificial light, but you must 
always keep composition in mind to achieve suggestive shots. Here are some suggestions on how to frame beautiful night-time 
urban pictures. 

7. LIGHT TRAILS AT NIGHT 

Keep the shutter open in order to record lights in movement. 
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LONG EXPOSURE TIMES 

In order to have the light trails visible in the photo but not the cars that produced them, you must use very long exposure t imes and 
a tripod. 

SPARKLING LIGHTS 

If you set the camera's aperture lower than f/11 you will obtain lights that appear as dots in the photo that become sparkling stars. 

STABILITY 

With long exposures it is absolutely necessary that the camera remains stable. Attach a weight to the central column of the tripod 
and use a remote shutter release. 

 


